
Welcome to EnterNet 300
EnterNet 300 for Windows Broadband Subscriber Client enables you to connect to high-speed, broadband networks like fixed 
wireless, cable modem, and Digital Subscriber Line (DSL) networks, using Point-to-Point Protocol over Ethernet (PPPoE). 
PPPoE allows Service Providers to use time-tested, PPP-based client authentication and configuration systems through any 
Network Driver Interface Specification (NDIS) 3.0-compliant communications device, such as Ethernet adapters and PCI- and 
USB-based DSL modems.

EnterNet supports most third-party Virtual Private Network (VPN) client software, and is also available for Mac and Linux 
operating systems.



System Requirements
To run EnterNet 300 for Windows, your system must meet the following minimum requirements:

Processor: Intel Pentium processor or equivalent

Operating System: Any of the following Windows operating systems: Windows 95, Windows 98, Windows NT 4 (Service Pack 4 
or newer), Windows Me, Windows 2000, and Windows XP.

RAM: 6 MB

Available Hard Drive Space: 10 MB

Network:    An NDIS 3.0-compliant communications device. EnterNet is optimized for use with Efficient Networks SpeedStream 
DSL modems



Getting Help for EnterNet
Online Help

Online help is available for most EnterNet features. To access online help, select Help Contents from the Connection Manager 
Help menu, select EnterNet 300 Help from the EnterNet 300 folder on the Windows Start menu, or, when present, click the ? 
button in the upper right-hand corner of any EnterNet screen.

Online Help Pop-ups

When viewing the Help file, when your cursor changes to a hand while passing over a particular region of the Help file graphic, 
simply click on the graphic to view an informational pop-up window.

ToolTip Help

Most EnterNet panels offer helpful ToolTips to assist with understanding the purpose or a feature, control, or setting.

FAQ

For additional assistance with EnterNet, go to the EnterNet Frequently Asked Questions (FAQ) page at: 
http://support.efficient.com/KB/NTS/index.shtml 



Connection Manager
The EnterNet Connection Manager helps you to create connection profiles, which you use to connect to your Service Provider’s 
network services.

To start the Connection Manager:

Click Start, select    Programs, then Efficient Networks EnterNet 300, and click EnterNet 300. (If you have an icon on your 
desktop named EnterNet 300, you can double-click this shortcut to open Connection Manager.)

Your Service Provider or Network Administrator should give you the information necessary to configure EnterNet. Store this 
information in a connection profile.    On the Connection Manager, double-click Create New Profile to start the configuration 
wizard.    The configuration wizard will explain the various parameters and help you select the right ones to create a connection 
profile.

EnterNet automatically discovers services carried by network servers, and displays these services as icons in the right-hand 
pane of Connection Manager.    These profile icons include a red bar to help distinguish them from other icons.    The Advertised 
Service icons use different colored screens to represent different levels of activity: Green signifies that a service has been 
discovered and is configured. Black signifies a service that has been discovered but remains unconfigured.

Note: If you do not see any services, the Show advertised services in the main folder option on the Application Settings panel 
may not be selected, or your Service Provider may have opted not to advertise any services.

See also Connection Profile.



Click to bring up the About menu for information on version.



Click to initiate a connection. 



Click to terminate your connection.



Click to display the negotiated addresses and statistics of your connection.    Menu is not clickable when    the connection is not 
active. 



Click to view the Properties menu of your current connection profile.



Click to view the Settings menu of your current connection profile. 



Click to view the Advanced menus related to your current session. 



The company logo for your Service Provider is displayed in this section.



The Profile name that refers to the parameters for this connection. 



Your User Name as configured at the network server. The Service Provider normally assigns your User Name to you. It is case 
sensitive.



Your Password as configured at the network server. The Service Provider normally assigns your Password to you.  It is case 
sensitive. If left blank, you will be prompted for the Password each time you connect.



After creating a new profile using the configuration wizard, the profiles are stored like a dial-up connection.



Click Create New Profile to bring up the configuration wizard.



Click the Views icon to toggle between the four display modes: large icons, small icons, list, and details.



Click to copy selected profile to clipboard.



Click to paste copied profile from clipboard.



Click to delete selected profile.



Click to refresh icon display.



Click the Edit menu to copy, paste, rename or delete a profile.



Click Next to continue with the configuration wizard.



Click Back to go to the previous dialog in the configuration wizard.



Enter Password a second time to confirm.



This scrollable text field displays the driver’s state as it progresses through the connection.  Click this field to display a window 
with a trace of the connection. 



Displays the state of the driver as it progresses through the connection.



Select your Ethernet adapter from the scroll bar.  Do not use the Microsoft Dial-up Adapter for EnterNet.



Click Connect to access your Network.



Click to save the parameters for this Profile.



Click the Delete button to remove a Profile.



Click Exit to shut down the EnterNet application. Any active connections are terminated.



Click Help for more information about the EnterNet application.



Connection Profiles
In EnterNet, the information needed to make a connection to your Service Provider is stored as a connection profile. Connection 
profiles include your user name and password, information about your computer, and information about your Service Provider's 
network. You create connection profiles using Connection Manager.

Connection Profile Types

EnterNet supports two types of connection profiles: simple connection profiles (also called simple profiles), and service 
connection profiles (also called service profiles). The difference between a simple profile and a service profile is that a service 
profile provides access to a specific service, whereas a simple connection profile does not.

Simple Connection Profiles

If your Service Provider offers only one class of service, you must create at least one simple profile to connect to their network. 
All subscribers on such a network have the same class of service, and access to the same features.

Service Connection Profiles

If your Service Provider offers more than one class of service (Basic, Expanded, and Premium, for example), you must create at 
least one service profile (instead of creating a simple profile) to connect to their network. On such a network, subscribers select 
the class of service they want, thereby gaining access to the features that are important to them.

If your Service Provider offers pay-per-use services, you must create additional service profiles to access them.

Connection Profile Shortcuts

To create a shortcut to an EnterNet Profile, select the Profile in the Connection Manager folder and drag it to the desktop. Once 
you place a Profile shortcut on the desktop, you can drag it anywhere Windows normally allows shortcuts to exit, such as the 
taskbar, the Start menu, or other Windows folders.



Entering User Name and Password
Your Service Provider uses your User Name and Password parameters    to authenticate your connection with the network.    
They are case-sensitive: "Password" is different from "PASSWORD" or "password".    Enter them exactly as your Service 
Provider or Network Administrator gives them to you. 



Locate Servers and Services
EnterNet is attempting to locate servers and services. 



Selecting Your Server and Service
The EnterNet application displays a list of network servers and services that may be available for you.    Select a specific network 
server and the available services provided by that server. The Server and Service fields are blank by default, which means the 
first available server normally will respond to your request for a connection. 

Leave these fields blank unless otherwise instructed by your Service Provider or Network Administrator.

Note:    Your Service Provider may have decided to display services that are not available to you. In this case, you will receive an 
authentication failure when you select one of these services and enter your user name and password.    If you have questions 
about services that you can see but not run, ask your Service Provider.



Saving the Profile
Once you have entered all the information for this profile, click Finish to save.    If you want to modify the configuration, click 
Back.



Services Tab
The Services tab on the Profile Properties panel displays a list of network servers and services that may be available for you to 
access on the network.    Select a specific network server and the available services provided by that server. The Server and 
Service fields are blank by default, which means the first available server normally will respond to your request for a connection. 
Leave these fields blank unless otherwise directed by your Service Provider.

You should request only the specific services that are assigned to you by your Service Provider.    Each 
of these services requires authentication using a user name and password. 



Click to clear the server and service fields.



User Information Tab
The User Information tab on the Profile Properties panel displays your user name and password. Normally, your Service Provider 
supplies this information.    Select Save Password to save your password so you do not have to enter it each time you want to 
connect.

Select Default Profile to mark this profile as the default profile.    If the area is grayed out, it means you have not created any 
other profiles, and this profile serves as your default automatically



The Service Name, if supplied by your Service Provider, is a qualifier that specifies the type of service permitted for your 
connection.    Normally this field is left blank.



This value is supplied by your Service Provider, if required.    It is used to connect to a specific network service. It is case 
sensitive.



Check this box to save the password for subsequent connections.



Click to mark this profile as the default profile.    If the area is grayed out, it means you have not created any other profiles, and 
this profile serves as your default automatically.



DSL Modem Tab
The DSL Modem tab on the Profile Properties panel displays information on detected Efficient Networks modems that allows you 
to adjust the configuration parameters of your DSL modem connection. 

The DSL Modem panel displays two different sets of options, depending upon whether you are using an Efficient Networks    PCI-
attached or USB-attached modem, or an Efficient Networks Ethernet-attached modem.

Ethernet Modems 

The Configuration portion of the panel contains two values: Virtual Path Identifier (VPI) and Virtual Circuit Identifier (VCI).    
These values are factory-set and you should leave them as they are unless directed by your Service Provider to change them.    
The bottom portion of the panel, Modem Software, contains a button labeled Update.    Your Service Provider may occasionally 
provide you with updates to your DSL modem software.    Press Update to install this newer version of modem software. 

PCI or USB Modems 

The upper portion of the panel, Status, contains a five-layer test to verify the status of your modem connection.    The bottom 
portion of the panel, Information, contains the outcome of your test.    Press Auto Configure to set the Virtual Path Identifier 
(VPI) and Virtual Circuit Identifier (VCI) parameters for your DSL modem automatically. However, the VPI and VCI values are 
factory-set and you should leave them as they are unless directed by your Service Provider to change them.

Note:    You must have SpeedStream DSL 3.0 (or higher release) drivers installed to see the DSL Modem tab for PCI and USB 
modems.



Click to restore values to their default settings.



Click to discover new values for settings.



Click to upgrade to a higher level of firmware.



Click to perform a five-layer test on your internal modem connection.



Click if you want to see the details of your test results.



Click if you want to autoconfigure your internal modem connection.



TCP Tab
The TCP tab on the Profile Properties panel displays information on how your addresses are assigned, the IP addresses for the 
Domain Name and WINS (NBNS) servers, and specifies connection details.

Select Idle Timeout to disconnect from the server after the specified period of inactivity.

The default settings are normally sufficient. Except for the Idle Timeout setting, which you are free to set, do not change these 
TCP settings unless directed to do so by your Service Provider or Network Administrator.



Enables automatic disconnection from the server after a specified period of inactivity.    Select the amount of time to wait before 
disconnecting.



Configuration Tab
The Configuration tab on the Profile Properties panel displays information on your Ethernet adapters. EnterNet supports multiple 
Ethernet adapters.    Select the Ethernet adapter this connection profile should use to communicate. 

Do not change the other settings unless directed to do so by your Service Provider or Network Administrator.



An Ethernet adapter to use for the connection.    Click the scroll arrow to see the supported Ethernet adapters.



Apply changes and close.



Select to establish PPPoE encryption (if supported by the network server).



Select to initiate network login over the connection.    This feature usually requires a VPN or encrypted connection and takes 
additional time to connect.    For logging into Windows networks, you need to have a WINS or NetBIOS Name Server address 
assigned by the network server.



Select if you do not want the routing table updated after the connection is established. Default setting (when box is not checked) 
is to direct all access over the connection.



Connecting to the Internet
Once you save your configuration, a new icon for the profile appears in the Connection Manager folder.    Double-click the new 
profile to bring up the Connection dialog, displaying the User Name and Password. Click the Connect button to establish your 
connection.  If successful, the Connection panel is minimized and moved into the system tray.    Otherwise, an error message 
displays. 

See the Connection Errors section for more information on errors.



Connection Messages
During the connection process, the Messages field displays the progress of the connection. The key messages are: 

Beginning Negotiation: Discovering and selecting a remote network server to connect with, and negotiating for the types of 
authentication available at the server.

Authenticating: Verifying the User Name and Password.

Receiving Network Parameters: Negotiating the IP Addresses and network configuration parameters.

Updating Network Parameters: Passing the received IP addresses to the TCP/IP protocol stack that is bound to the EnterNet 
adapter.

By default, the message window only displays a single line of message text. Double-click the message window to expand it to 
show multiple lines of messages.



Disconnecting EnterNet
There are several options for disconnecting from the Internet. 

To terminate your session and close the active profile connection:

Right click the EnterNet system tray icon and select Exit.

To terminate a session but leave the active connection profile open:

Right click the EnterNet system tray icon and select Disconnect from the pop-up menu.

Or

Double-click the EnterNet system tray icon and select Disconnect from the Connection Details Panel.



Click to disconnect the active connection.



EnterNet Connection Details
To determine the addresses that were negotiated for your session, right click the EnterNet icon from the system tray and select 
Connection Details. 

Note:    The system tray will only appear when a connection profile is running. 



Windows 95/98/Me Connection Details
To determine the addresses negotiated for your session, run WinIPCFG from the Windows Start menu, and select Run. Select 
the Ethernet Adapter that you are using to connect to the Internet to see the IP Addresses for this connection.   



Displays total time of current connection.



Number of Bytes sent during current connection.



Number of Frames sent during current connection.



Current count of bits per second transmitted.



Current count of bits per second received.



Click Disconnect to terminate EnterNet connection.



Displays the type of protocol used during connection.



Displays whether SecurID authentication has been negotiated with the server.



Displays IP address assigned from server.



Displays NetBIOS Name Server addresses assigned from server.



Displays negotiated networking protocols over EnterNet.



Click OK when finished.



Click Cancel to leave unchanged.



Windows NT Connection Details
Besides examining the Connection Details from the system tray, you can also monitor the assigned IP addresses by opening a 
DOS window and from the DOS prompt typing:

IPCONFIG

Windows NT IP Configuration

Ethernet adapterElnk31:

IP Address. . . . . . . . . :0.0.0.0

Subnet Mask . . . . . . . . :0.0.0.0

Default Gateway . . . . . . :0.0.0.0

Ethernet adapter NTSPPOE2:

IP Address. . . . . . . . . :198.87.72.30

Subnet Mask . . . . . . . . :255.255.255.0

Default Gateway . . . . . . :198.87.72.22 

In some cases you may see a 169.n.n.n address for the Ethernet adapter.    This is a local address and can be ignored.

For details about DNS addresses, Ethernet adapter information, and other information, from the DOS prompt type:

IPCONFIG /all |more

Note:    To open a DOS window, select Start, Programs, Command Prompt.



Dial-on-Demand Feature
EnterNet’s optional Dial-on-Demand feature eliminates the need to run and connect EnterNet manually when network-aware 
applications require network access.    Most modern network-aware software, like browsers and FTP clients, can open Dial-on-
Demand.

Activating EnterNet’s optional Dial-on-Demand requires a one-time user intervention. Dial-on-Demand does not need to be 
active for EnterNet to function fully in all other respects. You can safely elect not to activate EnterNet Dial-on-Demand. 

Activating Dial-on-Demand requires familiarity with Microsoft Dial-Up Networking, the Windows Connection wizard, and possibly 
Microsoft Virtual Private Networking. For more information on the Dial-on-Demand feature, see the EnterNet 300 User Guide and 
your Microsoft Windows documentation. 

To configure the Windows Connection wizard so that it will select EnterNet whenever an application asks it to establish a network 
connection:

1. From the Windows Start menu, open the Settings folder, then open the Control panel.

2. Run Internet or Internet Options.

3. Click the Connections tab.

4. Look for a window titled Dial-up settings. If you have this window, continue with steps 5-8. Otherwise skip to step 9.

5. In the Dial-up settings window, click EnterNet DoD. 

6. Select the Always dial my default connection radio button (or the button that best approximates that meaning.)

7. Click Set Default.

8. Click OK. You can skip the rest of the following numbered steps.

9. If you do not see a window titled Dial-up settings, select Connect to the Internet using a modem.

10. Click Settings.

11. Select EnterNet DoD from the pop-up window.

12. Save your new settings and close all windows you have opened.



Windows NT/2000/XP PPPoE Service
EnterNet runs as a Service on Windows 2000/NT/XP and places a Control Panel object named PPPoE Service in the Windows 
Control Panel. 

Opening the PPPoE Service Control Panel item produces the following window:

There are two PPPoE subservices running: EnterNetFolder and EnterNet, each shown as a butterfly icon. Select the 
EnterNetFolder icon and click Open to open the Connection Manager. Select the EnterNet icon and click Open to open the 
Connection panel.

Typically, when you first set up EnterNet, you open the EnterNetFolder icon, which starts the Connection Manager, where you 
can create the connection profiles you need. 

Once you have created the connection profiles you need, you can configure your default EnterNet profile to run automatically 
when Windows NT starts. To do this, click the EnterNet butterfly icon and then click the SubService loads when PPPoE 
Service starts check box. The default EnterNet profile will now run every time Windows NT starts. You can configure the default 
EnterNet profile to connect automatically when it is run, by clicking the Auto-Connect box on the Application Settings panel.

If you want Connection Manager to run automatically when Windows 2000/NT/XP starts, click the EnterNetFolder icon and click 
the SubService loads when PPPoE Service starts check box. Connection Manager will run every time Windows 2000/NT/XP 
starts, enabling you to select and run the desired EnterNet profile manually.

Note that you cannot have both EnterNet and EnterNetFolder configured to run at Windows NT start up.

For more information on PPPoE service, see the FAQ section at Getting Help for EnterNet. 



About Tab
The About tab on the Profile Properties panel displays information about company name, as well as versions and build dates.

Display the About menu by right clicking the EnterNet icon from the system tray. (The system tray will only appear when a 
connection profile is running.)    Please provide the Application version number, and Driver version number, when reporting 
problems. 

Note:    The Driver version does not appear until the driver has been accessed by clicking Connect on the main EnterNet 
interface.

 (See Connecting to the Internet for more information).



Date, time-stamp, and version of the Driver.



Click OK to leave the About menu.



Testing Your Connection
To display information about the session, right click the system tray and select Advanced.

Check your Network Properties from the Control Panel to verify that the TCP/IP protocol is configured for your Ethernet 
adapter.

Once connected, you can test your connectivity by opening a DOS window and entering the Ping command for each address 
displayed in Connection Details. Start by pinging your local IP address, then the IP address of the remote server, followed by 
pinging the DNS and NetBIOS Name Server addresses (if applicable). 

Note: To open a DOS window, select: Start, Programs, Command Prompt.    To enter the Ping command, from the DOS 
prompt, type ping, then the IP address of the device you want to check. The DOS screen will report that the device is alive or is 
not found. For more information on using the Ping command on your computer, see your operating system documentation or 
Help system.

If the Network servers are not responding, contact your Service Provider.  You cannot use the DOS Ping command to determine 
the name of the Network server or Access Concentrator, because the IP protocol is not active until the connection is established.



Application Settings
To open the Settings menu, click Settings on the system tray pop-up menu, or select Settings from the Connection Manager's 
Connection menu. 

Note:    The system tray will only appear when a connection profile is running. 

If there are no profiles, the Launch EnterNet at Windows Start-Up option is unavailable for selection. 

Note:    The auto launch feature is unavailable on Windows NT and Windows 2000 because this feature is controlled from the 
PPPoE services. For more information see: 

http://support.efficient.com/KB/NTS/windows.html#autoNT 

The settings indicated in the Application Settings menu are valid for every profile, not just the one that is running currently.

For information on the Advanced button, go to Advanced Settings.



Causes EnterNet to run automatically when Windows is started.



Automatically "clicks" the Connect button when the application has been run.



Click if you want ToolTips displayed when you rest the cursor over a value, region, or setting.



Click to enable detailed logging in the Messages window.



Click if you want to designate a unique URL for each profile.



Seconds of consecutive timeout since connection establishment.



Click if you want the application to play a .WAV file when a connection is established.



Check if you want your default browser to run automatically when EnterNet establishes a connection.



If selected, all services advertised by the network server are stored in the Connection Manager folder. Note: De-selecting this 
option will not remove these entries from the Connection Manager folder.



Selecting this will enable EnterNet to reconnect automatically after network failures or dropped connections from the server.



Default interface to update negotiated addresses for the connection.    Use this value unless recommended otherwise by your 
Service Provider or Network Administrator. 

If you are using VPN clients or ICS, you must use Dynamic Host Control Protocol (DHCP).



Uses the built-in DHCP server component in the EnterNet adapter. 



Default driver for EnterNet adapter.



Uses internal protocol driver in EnterNet adapter.



Selects the default settings for optimal performance.



Route Table Tab
Display this tab by right clicking the EnterNet system tray icon, selecting Advanced, then clicking the Route Table tab.

Note:    The system tray will only appear when a connection profile is running. 

This tab shows the routing details for every IP address configured for your session.    These details include the IP address and 
subnet mask, the gateway address and interface used, and the metric. The metric assigned to the address defines its priority in 
the routing sequence. The lower the number is, the higher the priority for routing. 

Click Color to differentiate the different interfaces.

To write the results of this tab, and all other Advanced panel tabs, to a file:

From the File menu, select Create Report and save the file with a name and location you choose.    If necessary, you can send 
this file to support personnel to troubleshoot EnterNet problems. 

In general, the information on this tab is only useful for support personnel.



Click to save information for EnterNet.



Tap Information Tab
Displays information useful to support technicians when they are diagnosing unusually complex problems. To display the Tap 
Information tab, right click the EnterNet system tray icon, select Advanced, then click the Tap Information tab. 

This tab includes detailed information on the adapter supporting the current connection as well as the connection itself. This 
information includes information on drivers, protocol, MAC address, IP address and subnet mask, gateways used to make the 
connection, DNS and WINS servers contacted, and the like.

To write the results of this tab, and all other Advanced panel tabs, to a file:

From the File menu, select Create Report and save the file with a name and location you choose.    If necessary, you can send 
this file to support personnel to troubleshoot EnterNet problems. 

Note:    The system tray will only appear when a connection profile is running. 



Packet Log Tab
A powerful diagnostics tool that helps advanced technical support personnel identify problems that can occur with the user login 
process. The tool captures, stores, and displays the Ethernet packets (also known as "frames") that are sent and received during 
the initial moments of a user’s attempt to connect to their ISP. This tab contains three sections: A Summary display, a Details 
display, and a Hex Dump display. The Summary display provides a single row of general information about each packet. The 
Details display provides in-depth information about the packet selected in the Summary display. The Hex Dump display 
provides the hexadecimal values for each byte in the packet that is selected in the Summary display.

The captured packets are stored in a non-scrolling buffer. Once the buffer is full, no new packets are captured or displayed. You 
can define the buffer size via a drop-down list box on the Packet Log Configuration panel. The contents of the buffer are 
cleared when you close the EnterNet application. The buffer is also cleared when you press the Connect button. To clear the 
buffer while you are connected, from the View menu select Clear Log, and then from the View menu select Refresh.

The Packet Log tab is not displayed unless you enable Packet Logging on the EnterNet Application Settings panel. Because 
enabling Packet Logging causes EnterNet to run slower than normal, only enable Packet Logging as necessary. 

To write the results of this tab, and all other Advanced panel tabs, to a file:

From the File menu, select Create Report and save the file with a name and location you choose.    If necessary, you can send 
this file to support personnel to troubleshoot EnterNet problems. 

For more information on packet logging, see the EnterNet 300 User Guide.



IP Tab
Displays addresses and TCP/IP related statistics and information for packets active on the device selected in the Description window.      This 
tab displays such information as the number of packets sent and received, transmission errors (which is an indicator of the quality of the 
connection), the Maximum Transmission Unit (MTU) negotiated for this session, and the line speed.    In general, the information on this tab 
is only useful for support personnel.

To display IP address and TCP/IP information:

Select the appropriate adapter in the Description box, right click the EnterNet system tray icon, select Advanced, then click the 
IP tab.

To write the results of this tab, and all other Advanced panel tabs, to a file:

From the File menu, select Create Report and save the file with a name and location you choose.    If necessary, you can send 
this file to support personnel to troubleshoot EnterNet problems. 

Note:    The system tray will only appear when a connection profile is running. 



Use color display to differentiate the addresses for each adapter. 



The metric assigned to the address defines its priority in the routing sequence. The lower the number is, the higher the priority 
for routing.

 



Diagnostics Tab
Tests the health of your network connection.    To display the Diagnostics tab:

Right click the EnterNet system tray icon, select Advanced, then click the Diagnostics tab. 

To test the availability of a particular device:

Click the icon that represents the device you want to test in the tree to the panel's left-hand side, and then click the Test button to 
the right of the screen.    Clicking the Test button sends a ping to that device.

Successful tests result in the appearance of the indicated request in the scrollable list to the right highlighted in green.    
Unsuccessful tests will result in the appearance of the indicated request in the scrollable list to the right highlighted in red.

To write the results of this tab, and all other Advanced panel tabs, to a file:

From the File menu, select Create Report and save the file with a name and location you choose.    If necessary, you can send 
this file to support personnel to troubleshoot EnterNet problems. 

Note:    The system tray will only appear when a connection profile is running. 



Enter a Name Server or IP Address to probe.



The results of the IP probe are displayed in this field.



Displays the status of the Domain Name Servers and other addresses negotiated during the connection.    If Green, servers have 
sent a response to the probe.    If Red, servers are not responding. If Yellow, at least one server is not responding but others are 
active.



The selected server or entry in the Network Health field will be sent an ICMP test probe.



Clears the display in the test field.



Drivers Tab
Displays information about the adapters configured for your system.    This tab shows the status of each adapter, the MAC and 
tap name, the protocol it is running, and a descriptive label. In general, the information on this tab is only useful for support 
personnel.

To display the Drivers tab:

Right click the EnterNet system tray icon, select Advanced, and then click the Drivers tab.

To write the results of this tab, and all other Advanced panel tabs, to a file:

From the File menu, select Create Report and save the file with a name and location you choose.    If necessary, you can send 
this file to support personnel to troubleshoot EnterNet problems. 

Note:    The system tray will only appear when a connection profile is running. 



Messages Tab
Traces protocol errors with the server.    In general, the information on this tab is only useful for support personnel.

This tab displays messages by category. Messages can be Normal (EnterNet is operating properly), Informational (no 
problem), Warning (a problem exists and needs to be fixed, but EnterNet is still running), and Error (EnterNet is not running 
properly and needs to be fixed). 

To display the Messages tab:

Right click the EnterNet system tray icon, select Advanced, and then click the Messages tab.

Note:    The system tray will only appear when a connection profile is running. 

To write detailed messages to this tab, from the Application Settings panel, click the Detailed Log check box. However, 
logging detailed messages can affect your computer performance, so only select this option when necessary.

To write the results of this tab, and all other Advanced panel tabs, to a file:

From the File menu, select Create Report and save the file with a name and location you choose.    If necessary, you can send 
this file to support personnel to troubleshoot EnterNet problems. 



DSL Modem Tab
The Advanced DSL Modem panel is a tool for monitoring the state of your DSL Modem connection. 

To open the Advanced DSL Modem panel:

Select the DSL Modem tab from the Advanced menu. 

To check the DSL line speed or connection statistics such as bytes and packets sent and received:
Examine the Activity section, located in the upper-right hand corner of the panel. 

To check the status of your connection:

Examine the Connection section, located in the upper-left hand corner of the panel.

To find various other specifics:

Examine the Modem Details section, in the bottom portion of the panel.

To write the results of this tab, and all other Advanced panel tabs, to a file:

From the File menu, select Create Report and save the file with a name and location you choose.    If necessary, you can send 
this file to support personnel to troubleshoot EnterNet problems.

Additional information on the connection status and troubleshooting suggestions appears in the Status Message section, which 
appears as a yellow line at the bottom of the panel.    If the connection is functioning properly and there are no messages to 
report, the Status Message section will not appear.

  



Displays the status of the connection. Note the last entry displays a successful connection.    If the connection fails, check for 
errors.



Installation Errors
Should any of the drivers for EnterNet fail to load, the application will fail.    The drivers are bound to the operating system during 
installation.

To verify that the drivers installed correctly, make sure the Efficient Networks PPPoE adapter is installed with TCP.



Connection Errors
Common connection-based errors are:

The Adapter Help Panels

Note: Adapter Help is available only on Windows 95 and Windows 98 systems.

When you click the Connect button to establish a connection with your Service Provider, EnterNet attempts to use the adapter 
that is associated with the connection profile in use. If that adapter is no longer available (or is not configured appropriately), 
EnterNet attempts to locate and use a suitable TCP/IP-bound Ethernet adapter. If it is not able to locate any Ethernet adapter, 
you see the following Adapter Help panel. 

If EnterNet is able to locate an Ethernet adapter, and if that adapter does not have a TCP/IP binding, the following panel 
appears:

In the lower-right corner of this panel you will find three radio buttons.    Selecting Adapters that can be used by EnterNet 
causes the following panel to appear:



The main window in this panel displays all the Ethernet adapters that are installed on your system, even if they do not have a 
TCP/IP binding.    For EnterNet to function correctly, you only need to bind TCP/IP to any of the adapters in the list.    Selecting 
the All adapters radio button produces the following panel:

This panel contains a list of all the adapters that are installed in your system.    Some of these adapters may not be suitable for 
EnterNet.





This is your Ethernet/DSL adapter.



This is your Efficient Networks adapter.



This is your TCP/IP bound Ethernet/DSL stack.



This is your TCP/IP bound ENI stack.



Help Screens Do not Match Program
EnterNet is a highly customizable program marketed primarily to Internet Service Providers (ISPs) who in turn redistribute it to 
their end-user customers. It is possible that this Help utility will display information about features that your EnterNet provider 
elected not to activate.



EnterNet not Displaying Discovered Server/Services
For Connection Manager to display icons for discovered Servers and Services, you must select the Show advertised services 
in the main folder check box in the Settings panel. If this selection is already made and Servers or Services are still not being 
displayed, click the Refresh button on the Connection Manager Toolbar. 

Note: Your computer's network interface card (NIC) must be installed, properly configured for use by EnterNet, and connected to 
a live PPPoE network. Also, EnterNet must be installed and configured before Server and Service discovery can occur. 

Note: Every functional PPPoE network should return at least one server when you click the Refresh button. However, Services 
are not necessarily present on any PPPoE network.



Uninstalling EnterNet
To uninstall EnterNet, from the Windows Start button navigate to the Programs folder, then to the EnterNet 300 folder. Double-
click Uninstall EnterNet 300 and follow the on-screen instructions. 

If you see a Remove Shared File? Message, it is safe to answer No to All. For more information, see the EnterNet 300 User 
Guide.

If uninstall fails, you can uninstall EnterNet by loading the original EnterNet 300 CD in your CD-ROM drive and running the 
REMOVEENTERNET.BAT file.



Internet Connection Sharing
Internet Connection Sharing (ICS) is a feature of the Windows 98 Second Edition operating system. It is also available on Windows 2000. 
ICS allows all the computers on your home Ethernet network to share a single Internet access device. EnterNet is compatible with ICS.

For more information on ICS, refer to the EnterNet 300 User Guide and the Internet Connection Sharing Overview section of the 
Windows Help system. 

To prepare EnterNet 300 to support ICS:

1. Install EnterNet only on the Connection Sharing computer. Do not install ICS before you install EnterNet.
When planning your network layout, keep in mind that the Connection Sharing computer must be running, and must 
be connected to the Internet, before other computers on your home network can access the Internet. In most homes, 
this means one computer will be left on at all times.

2. From the Windows Start menu, navigate to the Programs folder, then to the EnterNet 300 folder. Select and run 
EnterNet 300.

3. From the EnterNet application, click the Connections menu, then select Settings. 

4. From the Application Settings panel, click the Advanced button. 

5. From the Advanced Settings panel IP Configuration box, select the DHCP button. 

6. Click OK. 

To install the version of ICS that comes with Windows 98 Second Edition on your Connection Sharing computer:

1. From the Windows Start menu, navigate to the Settings folder, and open the Control Panel.

2. From the Control Panel folder, double-click Add/Remove Programs.

3. From the Add/Remove Program Properties panel, click the Windows Setup tab.

4. Select Internet Tools in the Components window, and click the Details button.

5. Select Internet Connection Sharing, then click OK. 

6. Click OK on the resulting panel.

7. Follow the on-screen instructions. 
You will probably need your Windows CD.

8. When asked What type of connection do you use to access the Internet?, select High-speed connection, then 
click Next.

9. When asked to Select the network adapter.... Select Efficient Networks PPPoE adapter from the list of adapters in 
the Network adapters window, then click Next.

 Note: To use ICS, you must have EnterNet 300 v1.31 or later.

10. When the ICS wizard notifies you that it is about to create a Client Configuration Disk, click Next. 

11. When the ICS wizard has finished creating the disk, click Finish and the ICS wizard    will continue configuring your 
system,. 
To complete the ICS installation process, you must reboot the computer. 

To configure each of the networked computers that will share your Internet access device (not the Internet Connection 
Sharing computer):

1. Insert the Client Configuration Disk in the floppy drive. 

2. From the Windows Start menu, navigate to the Programs folder, and run Windows Explorer. Select your floppy drive in the 
Folders window, then double-click the file named ICSCLSET.EXE.

3. When the Browser Connection Setup wizard appears, click Next. 

4. You will be presented with an information panel that tells you the wizard is about to check and, if necessary, change your browser 
settings. Click Next.

5. The next panel advises you that the wizard has completed its work. Click Finish.

6. Repeat steps 1 through 5 above, for each computer on your network, except the Connection Sharing computer.



EnterNet and ICS are now ready to provide Internet access to every computer on your home network. Be sure the Connection 
Sharing computer is connected to your Service Provider before you attempt to access the Internet from any of the other 
computers.

Note: Computers that share your Internet access device through ICS cannot activate Dial-on-Demand.    You must manually 
establish an EnterNet connection between your Connection Sharing computer and your Service Provider before the other 
computers on your network can access the Internet.    For more information about Dial-on-Demand, see EnterNet Dial-on-Demand. 



Creating Connection Profiles
To create a new connection profile, double-click the Create New Profile icon, located in the right-hand pane of the Connection 
Manager, or select Make New Connection from the Connection Manager Connection menu.    This runs the connection profile 
wizard, which guides you through the process of creating a new connection profile. 

When you create a new connection profile, EnterNet attempts to learn what it needs to know about your computer automatically, 
and in some cases EnterNet can learn all it needs to know about your Service Provider’s network automatically. However, when 
you create a new connection profile, you must provide your user name and password, and you may have to provide some 
information about your Service Provider’s network. See your Service Provider’s installation instructions for all the information 
you need to create connection profiles.

To create a new connection profile:

1. Start EnterNet Connection Manager.

You create and manage connection profiles using EnterNet Connection Manager.

Your Service Provider or Network Administrator has the information necessary to configure EnterNet.     Store this 
information in a connection profile.    On the Connection manager, double-click the Create New Profile icon to start the 
configuration wizard.    The configuration wizard will explain the various parameters and help you to fill them out 
correctly.

EnterNet automatically discovers services carried by network servers (see Note), and displays these service 
connection profiles as icons in the right-hand pane of the Connection Manager.    These profiles feature a red bar to 
distinguished them from other icons.    The Advertised Service icons use different colored screens to represent different 
levels of activity: Green means that a service has been discovered and is configured, while black means a service has 
been discovered but remains unconfigured.

2. Enter a profile name for your configuration. 

Enter any name you want to describe this collection of parameters required for your connection. 

Note: If you do not see any services, verify that the Show advertised services in the main folder option on the Application 
Settings panel is selected. If this option is selected, your Service Provider may have opted not to advertise any services.

For more information see Connection Manager 



Naming the Profile
Enter a name for the connection profile in the text field of the Connection Name panel. 

Note: The name you give to this connection profile does not have to be the same as the name of the user associated with this 
profile.



Advanced Settings
Clicking Advanced on the Settings menu displays additional settings in the Advanced Settings dialog box.    Do not change 
these settings unless directed to do so by your Service Provider.



 {ewl RoboEx32.dll, WinHelp2000, }




